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Note Editor View 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Note Editor View provides editing of the picture and text items contained in a note.  Tap and drag 
the Zone Size Button to make the viewable size of the picture larger or smaller.  The Picture Edit 
Tool Popup is in the lower left hand corner.  The Category Picker sets the category for this note. 
 
Picture Edit Tool Popup 
 
 
 
 
 
 
 
 
 
 
 
 

 
The pen, line, frame and eraser tools are contained in the first two rows of the popup.  These tools are 
adjusted for size using the Line Size setting.  Undo rolls back the latest change to the note if possible. 
Clear, Paste, Copy and Cut are commands for the region tool (dotted box) using the Palm OS system 
clipboard.  The Text command allows you to enter Graffiti information and paste it into the picture. 

Menu Button 
 

Category Picker 
Note Manager Button 
 

Previous, Add and 
Next Buttons 

Picture Zone 
 

Text Zone 
 

Zone Size Button 
 

SuperButtons 
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Tool Popup 
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Region commands 
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Circle, Square 
and Eraser tools  
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Note Manager View 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
The Category FILTER controls which notes are displayed in the Note List.  The Details Zone can be 
selected to either view the Picture, Details or Text information contained in a note.  The Details sub 
view gives detailed size information, allows you to resize the picture and change the category for the 
note. 
 
Important Note:  The Category PICKER is different from the Category FILTER.  The Category 
FILTER can be changed in the Note Manager.  If the Category FILTER is set to Business, you will only 
see notes in the Business Category.  Also notes will be added to the selected category.  If the selected 
category is All, notes will be added as unfiled.  The categories in SuperNote work very similar to the 
categories in MemoPad. 
 

Menu Button 
 

Category FILTER 
SuperButtons 
 

Note List 
 

Details Zone 
 -Details  
 -Picture 
 -Text  
 -Links 

Resize Picture 

Details  Zone 
Popup List 
 

SuperButtons 

Category PICKER
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Hierarchical Organization 
 

         
Link specific SuperButtons 

 
 
 

 
 
 
 
 
 
 
 

 
 
Links can be used to organize notes in to specific groups.  Links do not care about categories; a note can 
contain a link to any other note in your notes database.  Tapping on a link in the lower half of the screen 
will select that note as the current note.  It is possible for a note to be a child of multiple notes, and / or 
have multiple parent notes, SuperNote leaves it to you the user to enforce a strict hierarchical tree if so 
desired.  Links always appear in database order, i.e. if the database is alphabetically sorted, the link list 
will be also. 
 
Definitions: 
SuperNote Link: A link to another note.  The link is stored as the record ID of the target note. 
 
Specific SuperButtons aid and increase the ability to use and create links almost anywhere in the 
program.   
 
Add: Create a new link to a child note contained in the current note. 
Remove: Destroy the selected link (does not destroy the note, just the link contained in this note). 
View: Make the selected link to a child note the current note. 
 

Use the  button to find parent notes of the current note.  If only one parent is found, that parent is 

selected as the current note.  Use the  popup menu button to view all child notes linked to the 

current note.  Selecting a note from the list will make it the current note.    adds a new note as a 

child to the current note, and selects the new note.   adds a child link to the selected note, and  

creates a parent link to the current note. 
 
 

Current Note 

Links Area 
In Note Manager 

Parent Note 

 
Child Note 

Link 
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SuperButtons 
 
SuperButtons provide editing and record management for notes.  Which SuperButtons appear on which 
views (i.e. Note Manager View) can be configured in the Options Popup using the Button tab. 
 
Icon Name Comments 

 Add Note Button Use Options Popup to turn on/off new note dialog 

 Calculate  Calculates selected text as a mathematical expression  

 Sort DB Date Up Sort notes ascending by note creation date (held in record header) 

 Delete  Deletes current note with yes/no prompt 

 Duplicate  Duplicates current note (picture and text information) 

 Find Find selected text in notes (switches to find view) 

 Insert Function Popup Pops up Function Manager for editing/inserting functions 

 Import/Export View Changes View to Import/Export 

 Function Type Ahead Auto fills text in Text portion of note with closest function match 

 Move Note Backward Moves note to position before the previous note in category 

 Move Note Top Moves note to top position in database 

 Previous Record Switch current note to previous note in category 

 Note Editor View Changes View to Note Editor 

 Note Manager View Changes View to Note Manager 

 Note to Bitmap Insert Creates a bitmap insert from the picture portion of the note 

 Note to Text Insert Creates a bitmap insert from the text portion of the note 

 Option Popup Bring up the Options View 

 Picture Templates Show the Picture Templates Popup 

 Text Copy Copy the selected text to the clipboard 

 Text Templates Show the Text Templates Popup 

 Wordboard View Changes View to WordBoard 

 Find Parent Note(s) Move UP the note tree (in other words find which notes contain a link 
to this note as a child.) 

 Add Child Link Link an EXISTING note to this note.  (Link a child) 

 Add Child Note  Create a note, and link it to this note. (Add a new note as a child) 

 Rotate Region Rotates selected region 90% clockwise. (If possible) 

 Text Insert List of text inserts from current Text DB; controlled either on the Text 
Template Manager, or with the Text DB SuperButton. 

 Picture Insert List of picture templates from the current picture DB; controlled either 
on the Picture Template Manager, or with the Picture DB SuperButton.  Inserts the selected item if 
possible. 

 Text DB Selects default Text Template Database. 

 Picture DB Selects default Picture Template Database. 
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 Add Parent Link Links this note to another note, making the selected note the parent of 
this note.  The current note will NOTE gain a link, instead another note will gain a link to the current 
note. 

 Note Link List List of links contained in this note (child list).  Selecting an item in this 
list will show it. 

 Note List List of all notes in a scrollable popup for quick scrolling. 
 
 
The default settings for SuperButtons target record management on the Note Manager View, such as 
adding, deleting and sorting notes.  The SuperButtons on the Wordboard View and the Note Editor View 
are targeted at giving a generic set of operations to demonstrate the various features of SuperNote.  
There are very likely SuperButtons you will not use.  These SuperButtons can be changed to more useful 
buttons for you using the Options View.  Some SuperButtons create text templates or picture 
templates; some calculate equations or insert functions.  SuperButtons are the main way you can 
customize SuperNote. 
 

SuperButton Picker 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Selecting the Menu Command Info->Change SuperButtons shows The SuperButton Picker.  Current 
the Note Editor View is the selected function for the button in the upper left hand corner that is colored 
blue.  Selecting a different item in the list changes the selected button.  The available slots depends on 
which View you are on when selecting the menu option. 
OK  Save Changes to SuperButtons for this form. 
Cancel  Cancel Changes to SuperButtons for this form. 
Default  Load Default SuperButtons for this form. 

 
The very first option in the list results in default behavior on some views when changing the 5 Way 
default options. 

Selected SuperButton
 

List of SuperButtons 
 

Command Buttons 
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Calculate 
 

Select the text in the field containing the mathematical equation* that you want to calculate and tap the 
 (Calculate) SuperButton. 

*Equations must be infix form and contain numbers, Operators and Functions (custom or Built-in) 
Example Equation:  10*-Pi + SIN (PI/4) ^ COS (1.211)*EXP (.3) 
 
Numbers can be output in decimal or scientific format, use the #.# tab in Options.  Negative numbers 
are indicated using a leading minus sign (-) character.  The math engine carries eight digits of precision, 
with the eighth digit rounded.  Commas (,) are used for separating function parameters and are not 
supported as a number format. 
3.0112 3e8 3e+8 3.123e-08 1324.123423  –3.213e-8 00001 
 
Built -In functions     Built -In Operators 
ABS (x)  absolute value of x   + Addition operator 
ACOS (x)  inverse COS (x)   * Multiply operator 
ACOSH (x) inverse COSH (x)   - Subtraction operator/ “-1*” substitution 
ASIN (x)  inverse SIN (x)   / Divide operator 
ASINH (x)  inverse SINH (x)   ^ Power 
ATAN (x)  inverse TAN (x)   () Infix stack operators 
ATANH (x) inverse TANH (x)   , Infix parameter separation operator 
CEIL (x)  rounded up (x)    
COS (x)  cosine of x    
COSH (x)  h cosine of x    
EXP (x)  e ^x     
FACT (x)  x!     
FLOOR (x) rounded down (x) 
LN (x)  natural log of x 
LOG10 (x) base 10 log of x  
LOG2 (x)  base 2 log of x 
NEG (x)  negate x 
SIN (x)  sine (x) 
SINH (x)  h sine (x) 
SQRT (x)  square root (x) 
TAN (x)  tangent of x  
TANH (x)  h tangent of x 
TRUNC (x) same as floor 

 

 
Use this button to pop up the Function Editor.  Built-In 
functions include most of the common trigonometric functions 
for double precision calculations.  Custom functions allow you 
to use existing functions and multiple variables.  Functions are 
is not case sensitive.  Functions should not call themselves, or 
call functions that call the original function. 
 

 
Use this button to have SuperNote auto fill (type-ahead 
recognition) to insert the nearest matching function.  This 
button changes color when turned off.  This is a Toggle type 
SuperButton. 
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Wordboards 
 

Wordboards are designed to speed up text entry.  There are three types of Wordboards; Word, Key and 
Note. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tap the word in the list to insert it at the cursor in the field.  Word type Wordboards insert a space after 
the word.  Key Type Wordboards insert only the character or letter combination without appending a 
space.  Note Type Wordboards are the existing notes compiled into Wordboards (each Word is delimited 
using a space).   
The Wordboard Menu allows you to Delete Board, Note->Board, Board->Note.  Note->Board pops up a 
dialog asking you to specify Key or Word type Wordboard and enter a name; selecting ok will create a 
new Wordboard using the contents of the note to create a space delimited Wordboard.  Board->Note 
adds a new note, fills the text with the Word or Key type Wordboard space delimited. 
To modify an existing board, use the Board->Note command, edit the note with your changes, then use 
the Note->Board command create a new board.  Non-space delimited boards; i.e. boards containing 
sentences, can be created using Windows. 
Wordboards are limited to 500 words maximum for performance reasons. 

SuperButtons 

Wordboard 

Wordboard  
List 

Wordboard Type 
-Word 
-Key 
-Note 

Wordboard Menu 
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Import / Export 
 

Import and export from Memos, Calendar, Tasks and Contacts.  These are the standard applications that 
come with the Palm OS®. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The lower half of the screen is a list of records that can be imported.  View pops up a preview of the 
information.  Add will add a record containing the imported information.  Insert will insert the 
information at the cursor in the field in the upper half of the screen. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Text can be cut and paste from the field above.  Use the Clear button to clear out the fields in the 
Export Table.  Use the Fill button to fill the table is EOL (end of line) separated information.  Use empty 
lines to skip fields. 

SuperButtons 

Zone Size Button

List of Contacts 

Import Options 

Import/Export Type 
-Import Datebook 
-Export Datebook 
-Import Address 
-Export Address 
-Import ToDo 
-Export ToDo 
-Import Memo  
-Export Memo 

Export Table 

Export Options 
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Templates 
 

Templates are collections of pictures and memos that you can insert when you create a note. 
 

             
 
Tap the Close button to return to your note view.  The insert button will insert the picture or text into 
your note.  The DB button is used to add, delete and rename databases.  Standard Forms and Sign 
Diagrams are drop down lists of the available databases.  A picture template must be less then 64k 
compressed.  Use the following SuperButtons to speed creation of Templates. 

 Creates a new Picture Template from the picture contained in the currently selected note. 

 Creates a new Text Template from the text contained in the currently selected note. 
Both buttons use the currently selected database.  If no databases exist, a default database is created. 
 

Use  to select different Text Template databases.   will show a list of inserts corresponding the 

currently selected Text Template database.   and  work the same way with Picture Templates.  

Use the  button to rotate inserted picture templates. 
 
5 Way Controller 
Page Up/Down: Page through database items 
Page Left/Right: Page through databases 
Page Select:  Insert Selected Item 
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Find View 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The  SuperButton will query the notes database for the selected text on the current view.  If no text is 
selected when pressing , then the previous results are displayed.  The Find View will select the 
previously selected note if it is in the results.  The Cancel button will return you to your previous view and 
selected note (if possible).  The SuperButtons along the top are configurable, and dragging the Zone Size 
Control to the bottom of the screen can hide the text field.   Finds the next occurrence of the find 
string in the current note.  The find results appear in database order. 

 

 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

SuperButtons 
 

Find Items  
 

Find Text in 
all notes 

Find Text in 
Current Note 
 

Text to find 
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Options 
 

The Options View allows you to customize SuperNote.  The Defaults Button sets all options to default 
levels and returns you to SuperNote.  The Cancel Button doesn’t save any changes you make, and 
returns you to SuperNote.  The OK Button applies the changes you made while in Options, if any. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Bmp Scl Rate: This is how many pixels the scrollbars move the freehand image when scrolling.  Higher 
values produce faster scrolling, while lower values produce more precise scrolling. 
Flip Scrollbars To Left Side: Scrollbars will appear on left hand side of screen and popups. 
Pen Debounce: This is the number of pixels that the stylus is given for error.  A very low value will cause 
lines and squares to blink, and a very high value will cause these objects to be not very precise in size. 
Opaque paste regions: Determines whether regions that are pasted or dragged are transparently or 
opaquely drawn to the screen. 
Hide Field Lines in Graffiti Zone: Hides dashed lines in field in Graffiti Zone. 
Reset Categories: Sets the categories to Unfiled, Personal and Business, and changes all notes to unfiled. 
Note Defaults: Shows the New Note Settings popup. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Set: Show the Picture Dimensions Dialog for sizing the picture component of new notes 
Add notes to front of Database: Add Position, Front, Back, Next Note, Previous Note (with respect to 
current note) 
Insert Date/Time/Serial: Default text items to insert in notes, serial number is auto-incremented. 
Show Popup when adding notes: Show these options each time adding a note. 
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Configuring SuperButtons 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Select the SuperNote View you want to customize; Note Editor View is selected now.  The pick the 
button using the Button Position you want to change, the approximate position is shown on the left 
side, along with the icon that corresponds to the SuperButton Type.  Choose the SuperButton Type 
you want; Font Menu is shown above.  The 5 Way Button Map is configured for each screen here, the 
numbers correspond to the 5 Way Button Map.  Note the SuperButton Picker can also be used to 
configure the SuperButtons. 
 

Calc Options 
 
Calculate selected text:  Selected text is calculated. 
Line:  Calculates from beginning to end of current line. 
All:  Calculates the entire note, from beginning to end 
 
Show Error Popup:  Shows error display.  This is recommended. 
Popup:  Displays result popup display.  Good for checking work. 
Insert:  Inserts the answer at the cursor, using prefix and suffix  
Replace:  If text is selected, it is replaced with result 
Insert Functions (Type Ahead):  Also available using a 
SuperButton (  ), this will auto fill the closest match of a 
function. 

 
 

Number Options 
 

Precision: Shows all significant digits. 
Fixed: Fixed decimal format.  Good for money. 
Scientific:  Scientific format, good for very extreme values. 
Show trailing zeros:  Show zeros even if not significant. 
Decimal Places:  Applies to Fixed format 

Max Stack Depth:  Must be between 30-100.  50 default.  The higher the setting, the longer it will take 
for the stack to overflow if a function gets caught in a loop.

SuperNote View 
 

Button Position 
 

SuperButton Type 
 

SuperButton Type 
For 5 Way Button 

SuperButton Preview 
 

5 Way Button Map 
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Main Window Layout 
 

SuperNote supports editing multiple notes and template databases simultaneously.  SuperNote has four 
manager windows (Note, Insert Database, Category and Function).  A toolbar at the top of the form 
provides quick font configuration, user selection and buttons for each manager window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Manager Buttons 

 Note Manager – Addition, deletion and editing of notes.  Notes are edited in sub windows. 
 Category Manager – Rename, add and delete categories. 
 Text Template Manager – Add and remove Text Template databases.  Text Templates are edited 

in sub windows. 
 Picture Template Manager – Add and remove Picture Template databases.  Picture Templates are 

edited in sub windows. 
 Function Manager – Addition, deletion and editing of functions. 
 Wordboard Manager – Addition, deletion and editing of wordboards. 
 Archive Manager – Viewing, editing and deletion of archived notes. 

Drag and Drop Area Drop picture files here from explorer to add as new notes. 
 

HotSync UserID 
 

Note Manager 
 Note Editor 

 

Drag and drop area 
 

Manager Buttons 
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Managing Notes 
 

SuperNote catalogs application data by user, and every user gets one notes database.  The Note 
Manager, Category Manager and Find Note Dialog manage your notes database. 
 
Note Manager  
The icon in the left hand side of the Note Manager identifies the synchronization status of each note. 
 New Note, Never Synchronized. 

 Note has changed on PC since last synchronization, exists on handheld. 
 Note exists on handheld and is unchanged on PC since last synchronization. 
 Note will be deleted from both PC and Handheld after next synchronization. 
 Note will be moved to Archive Database on PC and deleted from Handheld after next 
synchronization. 
 

 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 
 
 
Category Filter 
The category filter controls the set of root notes you wish to view.  Basically every note is a root note, 
but if you put certain notes in a category, you can maintain a tree by having the child as unfiled, or in 
another category. 
 
Buttons and Right Click Menu Commands 
View Pops up note editor window 
Delete Deletes the note selected in the list 
Archive Archives the note selected in the list 
Add Adds note after selected item in list 
HH Sort Sorts Notes in last HotSync order 
Alpha Sort Sorts Notes Alphabetically  
Date Sort Sorts Notes Chronologically 
Note Up/Down Moves Selected Note 
Add Child Add new note, link it to this note as a child 
Select As Root Select this note as a root (note on far left side).  This can cause the Category 
Filter to change to All Categories if the parent and child categories do not match. 
Find Parent(s) Select parent linked note.  If multiple parents exist, displays popup for selecting 
the parent note.

Category Filter 
 

Right Click Item Menu 
 

Collapse and expand 
linked notes 



 

Page 16 of 23 - ©2004 Handtop. All rights reserved. 

Category Manager 
SuperNote allows up to sixteen categories for your notes.  The Category Manager is shown below. 
 

Add Add a category (Up to 16 total) 
Remove  Remove category (May change notes) 
OK Close Category Manger 
 
 
 
 
 
 

 
 
 
 
SuperNote provides the Find Note dialog for finding notes.  Double Click an item in the list to view the 
note. 
 

Find Find notes containing  
Disable AutoFind Shows Find Button 
Case Sensitive  If not check search ignores case 
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Editing Notes 
 

The Note Editor Window edits your notes.  You can have one or more of these open depending on the 
number of notes in your database. 

Email Create an email message window with 
the text as the message and the picture 
as a .gif attachment. 

Word Create a Word document window with 
the picture and text. 

Print Note  Sends this note to the printer 
Exp Pict  Export picture to .bmp file 
Imp Pict  Import picture from .jpg, .gif or .bmp 

file 
Links  Edit hierarchical links (Pops up Link 

Manager) 
Set Default  Set this window’s size, and pen setting 

to be used on all new note windows 
Details  Change Picture and view note details 
Apply  Apply changes without closing note 
Cancel  Close note and cancel changes 
OK  Close note and save changes 

 
 
 
 
 
 

Child Link Manager 
Add Add Children links to this note.  Use the 

combo box to drop a list of all notes. 
Remove Remove child link. 
View  View Child Link 
OK  Close dialog. 

 
 
 
SuperNote support bitmaps up to the size limits of your handheld computer.  Please check and test raw 
sizes on your handheld.  In general, up to 1000x1000 is acceptable for image sizes.  
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Data Backup and Recovery 
 

 
 
The Diagnostics popup is available from the Options Menu.  The following paths contain the Windows 
data files.  Before recovering data in your handheld, it is recommended that you backup your Windows 
based data files in case of complications. 
 
User Name:   Hotsync user name (selected on toolbar on main window).  
User Data Path:   Hotsync User specific directory; all HotSync specific files should be stored 
in this directory for the selected user.  
SuperNote Data Path:  All SuperNote specific data for the current user is stored in this directory 
and it’s sub directories.  
Main Note DB Path:   This is the main notes database path. 
Insert DB Path:   This is the directory path for all insert (template) databases. 
Archive Path:    This is the full archive database path for this user. 
Function DB Path:   This is the full function database path for this user. 
Wordboard DB Path:   This is the full wordboard database path for this user. 
Keyboard DB Path:  This is the full keyboard database path for this user. 
 
Backing SuperNote Databases 
Backing up all SuperNote Databases is most easily accomplished by backing up all information contained 
in the “SuperNote Data Path”.  Backing up data can be accomplished when you back up your entire 
computer, or periodically manually creating backup copies of this directory. 
 
Restoring SuperNote Databases from a Windows backup 
Restoring SuperNote databases is a two-step process.  The windows based information must be restored 
first.  Second a PC to HH synchronization needs to be performed (explained next).   
 
Restoring SuperNote Databases from Windows to the handheld 
The HotSync icon in the system tray can be right clicked and Custom… selected.  Choose the SuperNote 
for Windows conduit to configure, using the “Change…” button.  Choose the appropriate synchronization 
action, in this case the PC to HH synchronization option.  DO NOT select the “Set as Default” option to 
have synchronization return to normal after the next synchronization. 
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Printing Notes 
 

Printing notes in SuperNote can be done from the main tool bar or the file menu.  Selecting notes is done 
using the print manager.  Use <CTRL> to click and add single items, use <SHIFT> to select a region of 
notes. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Print Record Selection Dialog 

 
Selecting Print in the lower left corner sends the job to the printer.  Selecting Preview brings up the Print 
Preview screen.  The Print Preview screen is useful for testing print settings.  Selecting Setup brings up 
the Page Setup dialog (also accessible through the File menu).   
Notes can be printed on any size of paper you choose, and any size you choose dependant on your 
printer.  The Printer Setup Button allows you to select the printer and paper of your choice.  The Page 
Setup Button allows you to define the margins, header and footer content, and the proportionality of the 
individual notes.  The Preview Button allows you to render a page preview right on this screen.  The 
preview option, just like printing is processor intensive (slow). 
 

 
Page Setup Dialog: Layout Tab 
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The Printer button allows you to select the printer, paper and orientation of the printer attached to your 
system.  The Defaults button sets all Page Setup settings to default. 
 
The Layout Tab allows you to configure the following options: 
 
Notes High / Notes Wide 
This sets the number of notes printed horizontally (wide) and vertically (high) on a page.  A 1 Wide by 1 
High setting is 1 note per page and will produce the largest print out of a note.  The number of notes 
wide by the number notes high is the number of notes printed on a page.  For example 4 notes high and 
3 notes wide is 12 notes maximum per page.  When the Separator Lines are shown, the results of the 
Notes High and Notes Wide settings are easy to view. 
 
Hide Separator Lines – Hides the printed lines separating the notes vertically and horizontally. 
 
Paper Margins 
This tab allows you to set the paper margins in inches.  If you change the type or orientation of the 
paper type under the printer, you will need to adjust these accordingly.  
 
 

 
Page Setup Dialog: Note Details Tab 

 
The Note Details Tab allows you to configure the following options: 
 
Note Proportioning 
Bitmap Height:  Percentage of the notes height to be occupied by the bitmap. 
 
Graffiti Height:  Percentage of the notes’ height to be occupied by the Graffiti text. 
 
Expand Graffiti Height if possible:  If proportional scaling of the bitmap results in a bitmap shorter 
than the height allowed (the case a bitmap that uses maximum width), the Graffiti portion of the notes 
height is then increased to compensate. 
 
Bitmap Printing Details 
Distort Bitmaps:  Scale bitmaps without a fixed aspect ratio.  This type of scaling allows a square to 
become a rectangle, and may produce very funny looking results if you don’t what to expect. 
 
Clip White Space:  Trims the blank white space off the bottom and right side of a bitmap.  Use this 
feature to make picture items of note print as large as possible. 
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Text Printing Details 
Font:  Select the font for printing the Graffiti text portion of notes.  The Font button pops up the 
standard Windows 95 font dialog. 
 
Scale Font Size:  This option scales text font size down to fit entire contents of Graffiti note into the 
allowed printing area.  The Min Pt Scale is the smallest font size the scaling will produce. 
 

 
Page Setup Dialog: Header / Footer Tab 

 
The Header / Footer Tab allows you to configure the following options: 
 
Header and Footer Details 
Left, Center and Right Options: Allows you to choose from a list of options, such as user name, 
date, time and page number. 
Height:    Allows you to set the height in inches. 
Hide Header / Footer:  Hides the header information (frees up the space). 
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Managing Templates 
 

 
 
 
 
 
 
 
Picture and Text Templates work very similarly.  Path information is provided for easy redistribution of 
your insert databases.  Please HotSync and have an updated database on Windows before using for 
redistribution (new records on Windows do not have a PalmOS record ID until after HotSync). 
 
Delete Deletes Template Database from Windows.  (In order to permanently destroy a 
template database is to delete it from both platforms before synchronization). 
New Create a new Template Database on Windows  
Edit  Sorts Notes Chronologically 
OK Closes Manager Window 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Resize (Picture Only) Set Picture Dimensions 
Clipboard Place the template item on the clipboard 
Add Add new template item 
Set Default  Set Window height/width as default 
Delete Set Delete Flag (will be deleted at next Sync) 
Apply  Saves Changes 
Cancel Closes Window without saving changes 
OK Closes Window and saves changes 
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Managing Functions and Wordboards 
   

 
 
 
 
 
 
 
 
 
 
 
 
 
Import Show Import Wordboard Dialog for importing wordboards 
Add Add new item 
Delete Set Delete Flag (will be deleted at next Sync) 
Edit  Show Edit Wordboard Dialog 
Apply  Saves Changes 
Cancel Closes Window without saving changes 
OK Closes Window and saves changes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Load File Import Text based File 
Space/EOL Use spaces or EOL (end of line) to break up word items 
Add Add new word item 
Remove Destroy selected item 
Apply  Saves Changes 
Cancel Closes Window without saving changes 
OK Closes Window and saves changes 


